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Compliance with FCC guidelines for human exposure to Electromagnetic Energy (EME) at 
Transmitter Antenna sites generally requires that Personnel working at a site shall be aware of 
the potential for exposure to EME and can exercise control of exposure by appropriate means, 
such as adhering to warning sign instructions, using standard operating procedures (work 
practices), wearing personal protective equipment, or limiting the duration of exposure. For 
more details and specific guidelines, see Appendix A of the R56 Standards and Guidelines for 
Communications Sites (6881089E50) manual.

C a u t i o n

General Safety and Installation
Standards and Guidelines

ATTENTION!

Observe the following general safety precautions during all phases of operation, service and repair
of the equipment described in this manual. Follow the safety precautions listed below and all other
warnings and cautions necessary for the safe operation of all equipment. Refer to the appropriate
section of the product service manual for additional pertinent safety information. Because of the
danger of introducing additional hazards, do not install substitute parts or perform any unauthorized
modifications of equipment.

The installation process requires preparation and knowledge of the site before installation begins.
Review installation procedures and precautions in the Motorola R56 manual Standards and
Guidelines for Communications Sites (6881089E50) before performing any site or component
installation.
Always follow all applicable safety procedures, such as Occupational Safety and Health
Administration (OSHA) requirements, National Electrical Code (NEC) requirements, local code
requirements, safe working practices, and good judgment must be used by personnel. General
safety precautions include the following:
• Read and follow all warning notices and instructions marked on the product or included in this
manual before installing, servicing, or operating the equipment. Retain these safety instructions
for future reference.
• If troubleshooting the equipment while power is on, be aware of the live circuits.
• Do not operate the radio transmitters unless all RF connectors are secure and all connectors
are properly terminated.
• All equipment must be properly grounded in accordance with the Motorola R56 manual
Standards and Guidelines for Communications Sites (6881089E50) and specified installation
instructions for safe operation.
• Slots and openings in the cabinet are provided for ventilation. Do not block or cover openings
that protect the devices from overheating.
• Only a qualified technician familiar with similar electronic equipment should service equipment.

NOTE

• Some equipment components can become extremely hot during operation. Turn off all power to
the equipment and wait until sufficiently cool before touching.
• Maintain emergency first aid kits at the site.
• Have personnel call in with their travel routes to help ensure their safety while traveling between
remote sites.
• Institute a communications routine during certain higher risk procedures where the on-site technician
continually updates management or safety personnel of the progress so that help can be
dispatched if needed.
• Never store combustible materials in or near equipment racks. The combination of combustible
material, heat and electrical energy increases the risk of a fire safety hazard.
• Equipment shall be installed in site meeting the requirements of a “restricted access location,”
per UL60950-1, which is defined as follows: "Access can only be gained by service persons or
by user who have been warned about the possible burn hazard on equipment metal housing.
Access to the equipment is through the use of a tool or lock and key, or other means of security,
and is controlled by the authority responsible for the location.”

Burn hazard. The metal housing of the product may become
extremely hot. Use caution when working around the equipment. 
The warning label for hot surfaces is shown on the right.

RF energy burn hazard. Disconnect power in the cabinet to
prevent injury while disconnecting and connecting antennas.

All TX and RX RF cables’ outer shields must be grounded per
Motorola R56 requirements.

DC input voltage shall be no higher than 60VDC. This
maximum voltage shall include consideration of the battery
charging "float voltage" associated with the intended supply
system, regardless of the marked power rating of the
equipment. Failure to follow this guideline may result in
electric shock.

All TX and RX RF cables shall be connected to a surge
protection device according to Motorola R56 documents. Do
not connect TX and RX RF cables directly to an outside antenna.

C a u t i o n

IMPORTANT: All equipment must be serviced by Motorola trained personnel.

C a u t i o n

C a u t i o n

W A R N I N G

W A R N I N G

The Safety and Installation Information contained below supersedes any other safety information associated with the MTR 2000 product line.
Dated October 2009.



Computer Software Copyrights

The Motorola products described in this instruction manual may include copyrighted MOTOROLA
computer programs.  Laws in the United States and other countries preserve for MOTOROLA cer-
tain exclusive rights for copyrighted computer programs.  Including the exclusive right to copy or
reproduce in any form the copyrighted computer program.  Accordingly, any copyrighted MOTOR-
OLA computer programs  contained in the MOTOROLA products described in this Instruction man-
ual may not be copied or reproduced in any manner without the express written permission of
MOTOROLA.  Furthermore, the purchase of MOTOROLA products shall not be deemed to grant
either directly or by implication, estoppel or otherwise, any license under the copyrights, patents or
patent applications of MOTOROLA, except for the normal nonexclusive, royalty free license to use
that arises by operation of law in the sale of a product.

Copyright

Copyright © 2005 Motorola Inc.  All rights reserved.  No part of this manual may be reproduced,
transmitted, stored in a retrieval system, or translated into any language or computer language, in
any form or by any means, without the prior written permission of Motorola Inc.  

Trademarks

Motorola , MTR2000, Channel Scan, MDC-1200, Private Line, and Digital Private Line are trade-
marks of Motorola Inc.

IBM is a trademark of International Business Machines, Inc.

Windows is a trademark of Microsoft Corp.

Disclaimer

Some of the features described in this manual may not be currently available.



Manual Audience

This guide is intended for use by qualified communications technicians and
maintenance personnel who are to program, troubleshoot, and align
MTR2000 stations.

It is assumed that the user is familiar with general communications equipment
operation, alignment and maintenance, and is proficient in the use of align-
ment and servicing equipment.   

It would be helpful, but not necessary, that the user be familiar with the oper-
ation of MS-DOS™ and Windows™, and with IBM-PC™ (or 100% compat-
ible) computers.  
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Purpose of Startup Manual

The Radio Service Software (RSS) allows service personnel to optimize op-
eration of a new station and maintain the station.  

Startup Manual This Startup manual is an introduction to the RSS application; it provides   in-
formation which enables the user to:

• get the computer set up (see Part 2), 

• get the station connected to the computer (see Part 2), 

• get ready to program and maintain the station (see Part 3),  

• become familiar with the structure and capabilities of the RSS applica-
tion (see Part 3), and 

• become familiar with the structure and capabilities of the Online Help 
system (see Part 4).

Online Help System Besides containing an online copy of the Startup manual information, the On-
line Help system provides RSS application details which enable the user to:

• optimize a station through programming,

• maintain the station through the service features
- ii -



Documentation Conventions

Documentation conventions are used in this manual to highlight certain informa-
tion.

The area to the left of the text column contains key words and graphic symbols
which allow the reader to quickly identify desired information. 

The following text highlight symbols are used:

The caution symbol indicates a potential problem, unless the proper actions
are taken.  A caution also explains how to avoid the problem.

The note symbol indicates important information that helps improve the described
function.

The help symbol indicates a reference to further information in the Online Help.
Specific references are made to the Online Help topics;  topics are headings in the
Help document.  For example, to find Online Help information on a desired screen
element through the Help menu Contents command, the following note is pro-
vided:  

See Online
Help . .

Information is available in the Online Help under:  Help menu → Contents  →
How To Use the RSS Application  → Screen Elements.

For information on using Online Help, refer to Part 4, How to Use Online Help.  

CAUTION
!

Note
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The following conventions have been used to highlight words within the text:

<Angled
brackets>

Angled brackets are used to highlight key presses.  For example, <F1> and <en-
ter>.  

If two keys are pressed at the same time, the keys are connected by a dash.  For
example, <Shift>-<F1>.  

Bold Text Bold text is used to highlight screen text.  For example, the Help button, or the
Search menu.  

Italics Italicized text is used to highlight referenced sections.   For example, see subsec-
tion Toolbar buttons.  
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Technical Support

For technical support for this RSS product, contact:
Motorola System Support Center
1311 E. Algonquin Rd.
Schaumburg, Il, 60196
1-800-221-7144, from within the U.S. or Canada
(847) 576-7300, from outside the U.S. or Canada
FAX; (847) 576-2171
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Ordering Parts and Kits

For complete information on ordering required parts and kits, contact the appro-
priate facility:   

Address Phone No. FAX No.

United States
Motorola Inc.
Americas Parts Division
1307 E. Algonquin Rd.
Schaumburg Il, 
60196, USA

(800) 422-4210 (800) 622-6210Canada

International (847) 538-8023 (847) 576-3023

Mexico Motorola de Mexico
Huatabampo No. 50
APDO Postal 71064
Mexico DF 06700

(525) 584-4560 (525) 584-6843

Asia Motorola Singapore Parts 
   Centre
1302 Lor 1 Toa Payoh Siong 
   Hoe Ind Bldg.
#01-03/04
Singapore 1231

(65) 353-0311 (65) 353-9152

Australia &
New Zealand

Motorola Australia Ltd.
666 Wellington Rd.
Victoria 3170
Melbourne
Australia

(61) 3 566-7766 (61) 3 566-7910

Japan Nippon Motorola Ltd.
3-20-1 Ninomi Azabu
Minato-Ku Tokyo 106 
Japan

(81) 3 3440 3311 (81) 3 3440 3505

Europe,
Mideast &

Africa

Motorola GmBH
Heinrich - Hertz Strasse 1
D-65232 Taunusstein 4
Germany

(49) 6128 70 2137 (49) 6128 7 3538
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1
 Introduction

Through the Radio Service Software (RSS), a service technician can customize, align, and troubleshoot any 
MTR2000™ station.  

The RSS application:

• is run on a suitable IBM™ PC (or 100% compatible) computer. 

• is run under Windows™ 3.1, 95, 98, or 2000.

• provides a user interface which is similar to other Windows applications.  

• is supported by a built-in Online help system.   

The MTR2000 RSS is provided in Motorola kit RVN4148.  This kit in-
cludes the application software on two 3.5 inch diskettes and on CD, and
a hard copy of this Startup manual. The CD also contains an electronic
copy of the startup manual.
68P81096E15-D 1 - 1



Introduction
1.1 Purpose of the Radio Service Software

The major tasks performed with the RSS are:

• Optimizing a new installation

• Running Diagnostics and Checking Station Status

• Performing Post-Repair Alignment

Optimizing a new
installation

The tasks associated with Optimizing a New Installation are:

- Reading the station codeplug

- Verifying station configuration data

- Programming the station codeplug

- Programming the Wireline Configuration data

- Programming the Channel Information data

- Programming the TRC Commands data

- Programming the RF Configuration data

- Performing alignment

Running
Diagnostics and

Checking Station
Status

The tasks associated with Running Diagnostics and Checking Station Status are:

- Running Diagnostics

- Interpreting Station Status

- Using the Station Operation Controls

- Using Digital Metering

Performing Post-
Repair Alignment

The tasks associated with performing post-repair alignment are:

- Performing Post-Repair Alignment procedures
1 - 2 68P81096E15-D



Introduction
1.2 Summary of Equipment and Software Requirements

The RSS application runs on certain models of IBM-PC or PC-compatible com-
puters, including laptop models.  

The computer must be configured with specific hardware and software configura-
tions in order to support RSS operation.

The Windows PC must:

• Be running Windows 3.1, 95, 98, or 2000.

• Have Com1/Com2 RS232 Serial Connection.

• Have 3.5 inch floppy drive and/or a CD ROM reader.

+    Additional
Hardware

• A cable for connecting the station to a PC serial port.  
This cable, part # 3082056X02, has a DB9 connector at one end, and an RJ45 
connector at the other end.

The computer must be running MS Word or another word processing application
capable of reading .rtf (rich text format) files, in order to print entire sections of
the Online Help.  

You can also print out individual topics directly from the Online Help.
Note
68P81096E15-D 1 - 3



Introduction
1.3 Definition of Operational Terms

Terms Describing General Screen and Point Control (e.g., mouse) Operations

Click A click is performed by quickly pressing and releasing the left mouse button once.   

Click- and-Hold A click-and-hold is performed by pressing the left mouse button and holding it
down.   The mouse button is held down for the desired amount of time and then
released.

Double-click A double-click is performed by quickly pressing and releasing the left mouse but-
ton twice in quick succession.  

Select Move pointer (arrow or hand) to desired item and click the mouse button.  For ex-
ample the item could be a jump (where the pointer appears as a hand) or a menu
item (where the pointer appears as an arrow).  

Drag Dragging is performed by moving the pointer over a displayed object (e.g., icon)
or screen element (e.g., title bar of a window),  pressing and holding the mouse
button down, and moving the pointer in the desired direction to “drag” the chosen
item.  Dragging is quit by releasing the mouse button.  

Pointer – The pointer is usually in the shape of an arrow; its position is controlled by the
mouse.   

Pointer – The pointer becomes an arrow–question mark when the context-sensitive help is
active.   

Pointer – The pointer shape becomes a hand when the pointer is over a jump.  

Pointer – The pointer shape becomes an hourglass when the computer is busy.  

Pointer – The pointer shape becomes a stroked-through circle when the pointer is over a
data field that cannot be changed (that is, the  data field is read-only).  

?
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Introduction
Terms Describing Windows and Online Help Screen Elements

Application
Window

Each RSS application window contains a group of related fields.  These windows
are accessible by choosing appropriate commands from the File,  Personality,
Preferences, and Service command menus. 

Online Help
Window

The Help window contains information from the Online Help system.  

Title bar This bar contains the title of the Help system.  

Menu bar The Menu bar contains the menus for selecting commands.   

Toolbar This bar contains buttons for quickly accessing Help commands.

Topic A topic is the basic unit of information in a Windows Help system, just as a page
is the basic unit of information in a book.  A Windows Help system consists of a
series of topics.  

Jumps Jumps are used to move from one Help topic to another.  A hypertext jump usually
appears as green underlined text.  The reader can also jump from a graphic to a
help topic; this is called a hypergraphic jump.  

Bookmarks Bookmarks let readers mark places in the Help information.  The reader can then
use the Bookmark menu command to quickly return to a topic of interest.   

Annotation Annotations allow the user to add text information to a Help file.   

Glossary The glossary provides a definition of terms used in the RSS.  Each glossary term
is a hypertext jump to the desired information.  When the user activates a glossary
jump, the corresponding topic appears in a popup window.  A popup window is
closed as soon as the user clicks anywhere within the Help window.  The glossary
terms and phrases appear as green text, with a dotted green underline.  

Index The Index displays an alphabetical listing of words.  Each index word is a  hyper-
text jump to the desired information.  When the reader activates an index jump,
the corresponding topic appears.  The index words appears as underlined green
text.   
68P81096E15-D 1 - 5



Introduction
Context-
Sensitive Help

This is help information which can be accessed directly from an active RSS appli-
cation window.   
1 - 6 68P81096E15-D



2
 How to Set Up the Computer for

Programming and Service

This part describes:

• How to set up the computer as an RSS programming and maintenance tool.   

• How to connect the station to the computer.

See Online
Help…

Information is available in the Online Help under:  Help menu → Contents  →
How To Get Started.  

Setting up the computer involves the following tasks:

Copy the RSS application diskette(s), so that a backup of the RSS application software is
available. 

1. Configure the computer to run the RSS application.

2. Load the RSS application and RSS Online Help system.  

Note
68P81096E15-D 2 - 1



How to Set Up the Computer
2.1 Backing Up the RSS Application 3.5 inch Diskette(s)

The user installs the RSS application and Online Help onto the computer hard
disk from the 3.5 inch diskette(s) or the CD.

Before installing the application software, it is recommended that the original set
of diskettes be copied onto another set of diskettes.  Diskettes are copied through
the Windows File Manager or Window Explorer in Windows 95 or later.  

The copied set of diskettes is used as the working copy, and the original set
serves as a backup copy.  Store the backup copy in a safe place (away from
magnetic fields, moisture, and heat).  If the working copy becomes damaged,
retrieve the stored backup diskettes and make another backup copy.  Figure 2-1
illustrates this procedure.  

   

Figure 2-1        Copying Diskettes

1.   Copy the application 
software from the original 
diskette set through 
Windows.

2.   Store the original set of 
diskettes in a safe place.
2 - 2 68P81096E15-D



How to Set Up the Computer
2.2 Configuring the Computer

Configuring the computer involves checking to ensure that the required hardware
is available on the computer and that the required files and buffers are set up.  

To Check Available Computer Resources…

The required computer hardware configuration is described in Section 1.2.  

Windows 3.1… To check the available RAM and hard disk space through Windows 3.1:

1. Check the available hard disk space by viewing the message bar of the File 
Manager (this is under Program Manager and Main icons).  

2. Check the available virtual memory (RAM + hard disk swap space)  through
the Help menu → About File Manager command.  

4 MBytes of free virtual memory should be available to run the RSS.  For 
proper performance it is strongly recommended to have 4 MBytes free in 
RAM.  

If necessary, change the virtual memory settings through the Enhanced icon 
(this is under the Program Manager and Main and Control Panel icons).  

3. Check the number of files and buffers by viewing the config.sys file under the
C:\ directory.  This file can be viewed through the Notepad accessory (this
is located under the Program Manager and Accessories icons).    

If necessary, edit the config.sys file to change the number of files and buff-
ers to 50.  
68P81096E15-D 2 - 3



How to Set Up the Computer
Windows 95… To check the available RAM and hard disk space through Windows 95:

1. Check the available hard disk space by:

- Starting the Explorer (i.e., Start button, Program menu → Windows
Explorer command.

- Selecting the drive onto which the RSS is to be installed.

- Opening the hard disk property window to show the free disk space

2. Check the available virtual memory (RAM + hard disk swap space) through
the Help menu → About Windows 95 command.  
2 - 4 68P81096E15-D



How to Set Up the Computer
2.3 Installing the RSS Application and Online Help

The RSS application and RSS Online Help consists of several data files, text
files, an executable file, and an installation file.     

To install the RSS application and Online Help software onto the computer hard
disk:  

1. Through Windows, go to the File Manager (Windows 3.1) or the Explorer 
(Windows 95 or later).  

2. Select the appropriate source drive; (i.e., the diskette drive).  

The contents of the selected drive appears.  

3. If there is a info.txt file, open and read it.  

4. It is recommended that all running software programs be stopped during the
installation process, such as anti-virus software.

5. Initiate the installation onto the hard disk by double clicking on the set-
up.exe file.  

The user is prompted for the next diskette when the current diskette is finished 
and if the printable help file option is selected (see Note below).  

The following files are loaded during installation:

mps.exe - the RSS executable file.

info.txt - (if present) the text file outlines version-related information.  For example,
in subsequent versions of the application, an info file can highlight new RSS
functions and changes to the Online Help. 

mps.hlp - the Online Help file.  

*.rtf - the printable help source files which are created if the:
RSS with printable Help files          2 
option is selected during installation.  Refer to Printing Online Help in Part 4
for a list of the printable .rtf files.
If this option is not selected, the user is not prompted for the second diskette
during installation.Note
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2.4 Connecting the Computer to the Station

Figure 2-2 shows connections between the station and a PC-compatible
computer.  The procedure is:

1. Connect the DB9 end of the cable to the COM (communications) serial port 
of the computer.  

The COM port configured for the RSS is selected through the Preferences 
menu → RSS Configuration window in the RSS application.  

2. Connect the RJ45 end of the cable to the RSS port connector, located on the
Station Control Module (SCM).  

  

Figure 2-2        Station –  Computer Connections

1. DB9 or DB25 end of cable is connected to 
COM port on computer.

2. RJ45 end of cable is connected to 
RSS connector on SCM.

1.8m (6ft) Cable 
Part # 3082056X02 
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 How to Program and Maintain the

Station

This part introduces the RSS application, enabling the user to be ready to maintain or program a station.  

Detailed information on maintaining and programming a station is contained in the Online Help.  

The following information is provided: 

• Starting up the RSS application – ready to service station or get ready to program station (Section 3.1).

• Using the RSS application; i.e., using screen elements, RSS commands, and RSS application windows 
(Section 3.2).

• Optimizing a newly installed station (Section 3.3).

• Servicing the station (Section 3.4).

• Managing Codeplug Data Files (Section 3.5).

All of the screen images shown in this manual represent the RSS running under Windows
3.1;  these images are slightly different in the Windows 95 environment.

Note
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3.1 Starting Up the RSS Application

See Online
Help…

Information is available in the Online Help under:  Help menu → Contents  →
How To Get Started  → Starting the RSS Application.

To start up the RSS application:

1. Access the Windows Program Manager window.

2. Open the RSS Program group icon by double clicking on it.  

3. Launch the RSS application by double clicking on the MTR2000 application
icon.

4. The RSS application starts.

The application information box appears (see Figure 3-1), with the main ap-
plication window (see Figure 3-2).   

Close the application information box by clicking on it; otherwise it closes 
automatically after about 15 seconds.

  

Figure 3-1        Application Information Box
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Figure 3-2        Main Application Window
68P81096E15-D 3 - 3



How to Program and Maintain the Station
You Can now…            

At this point the user can:

• service a station which is connected to the COM port.  

• read station codeplug data from a station or stored file

• create new codeplug data based on a default template

Codeplug Data File In order to program the station, it is necessary to have a codeplug data file
available to the RSS.    A codeplug data file contains the set of data which defines
the operating characteristics of a station.   

Get Ready to Program the Station

To read codeplug data into the RSS:

1. Read codeplug data into the RSS by:

- opening an existing codeplug data file, or

- creating a new  codeplug data file (based on a default  codeplug data 
file, or

- reading the codeplug data from a station connected to the computer.

2. For example, if reading an existing file, select the File menu Open com-
mand.  

The File Open window appears (see Figure 3-3).  

3. Select which file is to be read.  

4. The Station Configuration window appears (see Figure 3-4).
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File Open Window The following fields allow the user to specify which file to open:

File Name Type in or select the file name to be opened.  The list box displays files with the
extension selected in the List Files of Type box. 

List Files of Type Select the type of file to be opened; the default file type for the RSS is .pcf

Drives Select the drive in which the RSS stores the file to be opened. 

Directories Select the directory in which the RSS stores the file to be opened.

  

Figure 3-3        File Open Window
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Station Configuration
Window

After a codeplug data file has been read, the Station Configuration window
automatically appears.     

The Station Configuration window shows the following information read
from a file or station:
- overall configuration for the station and 
- codeplug data file information.

The RX Frequency Band, TX Frequency Band, and Power Level fields
are read-only.  

If it is required to reconfigure the station hardware, access the Edit Configura-
tion window by pressing the Edit Config button. 

Close the codeplug data file by pressing the Close button.  If the data was not
saved to file before, the save is forced. 

 

Figure 3-4        Station Configuration Window
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3.2 Using the RSS Application

See Online
Help…

Information is available in the Online Help under:  Help menu → Contents  →
How To Use RSS to Maintain and Program the Station  → RSS
Window Elements → desired element.

The RSS application is displayed with the common elements of any Windows 3.1
application.

See the Main RSS Application Window Screen Elements subsection for
information about the basic RSS application display.  

See the following subsections for further details on the display elements:
- Menu Bar Items
- Toolbar Commands
- Application Commands
- RSS Application Windows
- RSS Application Window Elements

In the following descriptions, the term “active codeplug” is used.  A codeplug
file becomes active when it is selected (e.g., by clicking on an RSS window with
the codeplug file name shown in the title bar).   Note
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Main RSS Application Window Screen Elements
  

Figure 3-5        Typical Main RSS Application Window

A typical RSS application window is shown in Figure 3-5.  This displayed
window has the following screen elements:

Title Bar The title bar of the main RSS application window indicates the name of the RSS
application, followed by the currently active codeplug file.    

The indicated file name is important, since this is the file on which:
- all File menu commands (such as Save, Save As…, Write Station, and 

Print) are performed on.  Particular attention should be paid when several 
codeplugs are open at the same time.  

- all Personality menu commands are performed on.  

Title Bar

Menu Bar

Toolbar

RSS
Application

Window

Icon

Status Bar

Note
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Menu Bar This set of command menus provides access to the currently available application
commands.   

Before codeplug data is available to the RSS, a set of menu bar commands and
toolbar commands can be executed.  This same set of commands is available
whenever the Message window is active.  

After the codeplug data is available to the RSS and active (which is confirmed in
the main RSS application title bar), a larger set of menu bar commands and toolbar
commands can be executed.  

See the Menu Bar Items subsection for menu information. Table 3-1 lists the menu
bar commands, and identifies which commands are only active after codeplug data
is available to the RSS (see the Comment column).  Commands which are also ac-
cessible through Toolbar buttons are listed under the Toolbar Button column.  

See the Application Commands subsection for more details on menu commands. 

Toolbar This bar contains buttons for quick access to application commands.

See the Toolbar Commands subsection for toolbar information. Table 3-2 lists
toolbar commands, and identifies which toolbar commands are only active after
codeplug data is available to the RSS. 

RSS Application
Window

An RSS application window is a screen box which provides a means of interfacing
with the RSS.  These windows are used to open codeplug data files, change station
parameters, display messages, run diagnostics, and so on.  

See the RSS Application Windows and RSS Application Window Elements subsec-
tions for more details.   

Icon An icon represents a minimized window.

Status Bar This bar displays messages and prompts related to current activity.  
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Menu Bar Items 

Before codeplug data is available to the RSS 
or when the Message window is active…

With codeplug data available to the RSS and active…
      

Table 3-1        Menu Bar Commands

Menu Command Toolbar 
Button Comment

File New

Open

Read Station

Close

Codeplug data must 
be available and 
active in order for 
these commands to 
be active.

Save

Save As...
Write Station

Print

Print Preview
Print Setup
1, 2, 3, 4
Exit
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Edit Undo

Codeplug data must 
be available and 
active in order for 
these commands to 
be active.  

Cut

Copy

Paste

Clear Message window 
must be active.  

Personality Station 
Configuration...

Codeplug data must 
be available and 
active in order for 
these commands to 
be active.  

RF Options...
Wireline...
TRC Commands...
6809 Trunking
Wildcard
Channel Information

Service Station Status 
Information
Station Error Log
Station Operation 
Controls
Station Alignment
Station Diagnostics
Station Metering
Station Upgrade
Edit Serial Number

Preferences RSS Configuration...

Table 3-1        Menu Bar Commands (Continued)

Menu Command Toolbar 
Button Comment
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View Toolbar
Status Bar

Window Cascade
Tile
Arrange Icons
1, 2, 3, 4…

Help Contents
Using Help
Index
Glossary
About RSS...

Table 3-1        Menu Bar Commands (Continued)

Menu Command Toolbar 
Button Comment
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Toolbar Commands 

 Before codeplug data
is available to the

RSS…

After codeplug data
is available to the

RSS…

New Open Read
Station

About
RSS...

Context
Help

Table 3-2        Toolbar Commands

Command Comment

New
Open
Read Station
Save

Codeplug data must be available and 
active in order for these toolbar 
commands to be active.  

Write Station
Cut
Copy
Paste
Print
About
Context Help

New

Open

Read
Station

About
RSS...

Context
Help

Paste

Copy

Cut

Write
Station

Save

Print
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Application Commands

This section provides a brief description of each available RSS command.  The
commands are listed under the menus which contain them.  

See Online
Help…

Information on the available commands is available in the Online Help under:
Help menu → Contents  → How To Use RSS to Maintain and Program
the Station →  RSS Menus / Command Descriptions → desired menu →
desired command.  
This information is also available directly through the Context Help.  
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File Menu
Commands

The New… command is used to create a new codeplug data file from scratch.  A
codeplug data file is opened from the default directory.  

The Open… command is used to open an existing codeplug data file in a new
window.  Multiple codeplug data files can be open at one time.  Use the File
menu 1, 2, 3, 4 command to switch among the multiple open and most recently
closed codeplug data files.  Use the Window 1, 2, 3, 4,… command to switch
among the multiple open windows.   

The Read Station command is used to read a codeplug data file from the
station. This requires a connected station via the COM port.

The Close command is used to close the active codeplug data file.  It is
recommended that the user save file changes before closing it.  If a codeplug data
file is closed without saving, all changes made since the last file save are lost.
Before closing a new Station Configuration - NONAME window or closing
an altered Station Configuration - station window, the RSS displays the
Save Changes to popup, allowing the user to confirm that the codeplug data is
to be saved.  Selecting YES causes the Save As window to appear, which
prompts for the codeplug data file to be named and saved to disk.

The Save… command is used to save the active codeplug data file to its current
name and directory.  When a new codeplug data file is saved,  the Save As
window is displayed, allowing the user to name the file.  To change the name and
directory of an existing file before saving it, select the Save As command.  

The Save As… command is used to save and name the active codeplug data file
to disk.  The Save As window appears.  To save a codeplug data file with its
existing name and directory, use the Save command.

The Write Station command is used to write the active codeplug data file to the
station.  This requires that a station be connected to the computer via the COM
port.

The Print command is used to print the active codeplug data file.  When this
command is selected, the Print window appears.  The user can specify the range
of pages to be printed, the number of copies, the destination printer, and other
printer setup options.
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The Print Preview command is used to display the active codeplug data file as
it would appear when printed.  When this command is chosen, the main window
is replaced with a print preview window in which one or two pages are displayed
in their printed format.  The print preview toolbar offers options to view either
one or two pages at a time; move back and forth through the codeplug data file;
zoom in and out of pages; and initiate a print job.

The Print Setup… command is used to select a printer and a printer connection.
This command presents a Print Setup window, where the user specifies the
printer and its connection.  

Currently open files and the most recently closed files are listed and numbered
1, 2, 3, 4.  Select one of the listed  files to be opened.  

The Exit command is used to end the RSS session.  The window Control menu
Close command can also be used.  The RSS prompts the user to save codeplug
data files with unsaved changes.

Edit Menu
Commands

The Undo command is used to reverse the last editing action, if possible. 

The Cut command is used to remove the currently selected data and put it on the
clipboard.  Cutting data to the clipboard replaces the contents previously stored
there.  

The Copy command is used to copy selected data onto the clipboard.  Copying
data to the clipboard replaces the contents previously stored there.

The Paste command is used  to insert a copy of the clipboard contents at the
insertion point.  

The Clear command is used to acknowledge and clear the messages from the
Message window.  This command is available when the Message window is
active.  

Personality Menu
Commands

The Station Configuration… command is used to access the Station
Configuration window.  This window shows station information read from a
file or station; that is, overall configuration for the station and codeplug data file
information.  
3 - 16 68P81096E15-D



How to Program and Maintain the Station
The RF Options… command is used to access the RF Options window for the
currently active codeplug data file.  This window contains all parameters
associated with RF options.  

The Wireline… command is used to access the Wireline window for the
currently active codeplug data file.  This window contains all parameters
associated with wireline interface options.  

The TRC Commands… command is used to access the TRC Commands
window for the currently active codeplug data file.  This window contains all
parameters associated with Tone Remote Control commands. 

The 6809 Trunking… command is used to access the 6809 Trunking window
for the currently active codeplug data file.  This window contains all parameters
associated with 6809 Trunking.  

The Wildcard… command is used to access the Wildcard window for the
currently active codeplug data file.  This window contains all parameters
associated with  Wildcard input/output configuration.  

The Channel Information command is used to access the Channel
Information window for the currently active codeplug data file.  This window
contains all parameters associated with channel information.  
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Service Menu
Commands

A station must be connected to the computer in order to execute any of the
Service commands.

The Station Status Information is used to view the stations operating mode,
the firmware version number, and status of the hardware modules. 

The Station Error Log command is used to display the error messages logged
in the station memory.  The station logs errors which are significant to station
operation.  These error messages can be used by a service technician for analysis
of station operation.  

The Station Operation Controls command is used to view and/or modify
selected station parameters.  The user can change current channel, speaker
volume level, squelch, intercom, and disable access to the station by non-RSS
users.     

The Station Alignment command is used to view and/or modify selected station
alignment parameters.  The user can change station alignment for the Reference
Oscillator, Audio Input/Output, Receiver and Transmitter.    

The Station Diagnostic command is used to run all available diagnostics
manually. 

The Station Metering command is used to access various critical metering
points throughout the station circuitry and display the current voltages, levels,
status, etc. 

The Station Upgrade command is used to select and transfer station software
files to the connected station and to update the feature set available in the
connected station. 

The Edit Serial Number command is used to modify the serial number of the
station.  

Preferences Menu
Command

The RSS Configuration… command is used to predefine the configuration of
the RSS.  Pressing the OK button activates all changes and stores it to disk.   
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View Menu
Commands

The Toolbar and Status Bar commands are used to switch on or off the
viewing of the Toolbar or Status bar.  

Window Menu
Commands

The Cascade command arranges windows so that they overlap. The title bar of
each window remains visible, making it easy for the user to select any window. 

The Tile command arranges the windows side by side, so that each window is
visible and none overlap. 

The Arrange Icons command is used to arrange the icons for minimized
windows at the bottom of the main window.  If there is an open window at the
bottom of the main window, then some or all of the icons may not be visible
because they will be underneath this window.  

The names of the currently open windows are numbered (1, 2, 3, 4,…) and
listed.  A check mark appears in front of the active window name.  A window can
be chosen from this list to make it active.  All open directory windows are listed,
including those that have been reduced to icons. 

Help Menu
Commands

The Contents command  is used to display the opening window of Help.  From
this opening window, step-by-step instructions can be jumped to, for using the
RSS and various types of reference information.  Once Help is open, the
Contents button can be pressed to return to the opening Online Help
Contents window.  

The Index command is used to display an alphabetical listing of topics which are
organized according to key RSS subjects.  Each index topic is a jump to the
desired information.  When the reader activates an index jump, the corresponding
topic appears.

The Glossary command is used to display an alphabetical listing of terms used
for the RSS.  Each glossary term is a hypertext jump to the desired information.
When the reader activates a glossary jump, the corresponding definition appears
in a popup window. 

The Using Help command is used to display information describing how to use
Help.  
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The About RSS command is used to display the copyright notice and version
number of this copy of the RSS.

Context Help
Command

The Context Help command is only available through the Toolbar and is used to
obtain help on some portion of the RSS.  When the Toolbar's Context Help button
is chosen, the mouse pointer changes to an arrow and question mark.  Clicking
somewhere in the RSS window, such as another Toolbar button, causes the
associated Help topic to be displayed.

RSS Application Windows

RSS application windows consist of:
• the Message window and 
• command-initiated windows.

Message window The Messages window is always shown, either as an open window or as an icon.
This is a list box which displays a log of error and warning messages.  Clicking
on a message which is related to an RSS window, causes that window to be
displayed.  

Other RSS windows are displayed when the following RSS commands are
selected:

File Menu - New
- Open
- Read Station
- Save As...
- Write Station
- Print
- Print Preview
- Print Setup

Personality Menu - Station Configuration
- RF Options
- Wireline Interface
- TRC Commands
- 6809 Trunking
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- Wildcard
- Channel Information

Service Menu - Station Status Information
- Station Error Log
- Station Operation Controls
- Station Alignment
- Station Diagnostics
- Station Metering
- Station Upgrade
- Edit Serial Number

Preferences Menu - RSS Configuration
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RSS Application Window Elements

The following control elements are used to enter information within the RSS; for
example, change station parameters.  

Command
Button

Graphical representations of buttons on the application windows are used to exe-
cute commands. A command button is effectively pressed by clicking on it.   

Text Box A text box allows the user to key in the required information.  When the pointer
is over a text box, and the mouse button is pressed, the cursor changes to an I-
beam ( ) – data can now be keyed into the box.  

Highlighted text in a text box is replaced by starting to type;  the original text is
replaced with the typed in text.  

A text box is selected by clicking once in the text box.  

All of the text in a text box is highlighted by double-clicking in the text box.  

Option Buttons Also called Radio Buttons, a set of options is listed with circles beside them.  Only
one of the set can be selected.  

Select an option by clicking on the appropriate circle.  The circle becomes dark,
and any other option button already dark, becomes empty.  

List Box A list box contains a list of options.  If the list is longer than the list box, use the
scroll bar to view the remaining options.  For a continuous scroll of a long list,
click-and-hold on the desired arrow.

Select a list option by double-clicking on the desired option.  
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Drop-down List Some fields have a predefined list of possible options.   Clicking on the arrow (m),
or the field to the left of this arrow, causes a popup list to appear. 

 Select the desired option by dragging the pointer to an item and releasing the
mouse button, or by double-clicking on the option. 

 If there are more options than can be shown all at once, scroll bars appear in the
right border of the list box.  

Slider Control A slider control is used to adjust  level; for example, the sound volume level.  This
control is adjusted by moving (dragging) the control pointer to the desired posi-
tion.  

Check Box A check box is used to set a condition that has two options.  A check box is turned
on (with an X in it) or off (empty).  Turn a check box on or off by clicking in the
check box.  

Increase/Decrease
Box

An increase/decrease box is used to change the displayed value up or down by one
unit.    Adjust the displayed value by clicking on the up arrow to increment the
value, or by clicking on the down arrow to decrement the value.  For a continued
change of the value, click-and-hold on the desired arrow.  The value can also be
changed by keying in a new number.  
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3.3 Optimizing a Newly Installed Station

Ensure that the original station codeplug data is saved before optimizing a
newly installed station.  Make an archive copy of the codeplug.  For
information on managing codeplug files, refer to Section 3.5.  

See Online
Help…

Information on optimizing a newly installed station is available in the Online
Help under:  Help menu → Contents  → How To Optimize a New
Installation.  

The process for optimizing a newly installed station is illustrated in the flow
diagram of Figure 3-6.   

CAUTION
!
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Figure 3-6        Optimization Flow Chart    

Alignment is performed for:
- Rx Wireline and Tx Wireline, if applicable.  
- Discriminator Audio, if required, according to system 

configuration.
- RSSI, if required, for an antenna network.  
- External Preselector Tuning if  External Preselector is be-

ing added to station.

Refer to Section 2.4 for details.

Read codeplug data from station into computer.  

Examine station configuration data already programmed 
into the station and verify that data agrees with equipment 
at site.

Customize the data for the particular station by 
programming data in the Personality windows.  

Save the customized codeplug data to an archive file on 
the computer.

Save the customized codeplug data to the codeplug in the 
station.

Perform series of tests to verify that optimization was 
successful and that station operates properly.

Connect Computer 
Running RSS 

Application to Station

Read the Station 
Codeplug

Verify Station 
Configuration Data

Customize the 
Codeplug Data

Save Codeplug Data to 
Archive File

Save Codeplug Data to 
Station Codeplug

Perform Station 
Alignment

Perform Post-
optimization Checkout
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3.4 Servicing the Station

See Online
Help…

Information is available in the Online Help under:  Help menu → Contents  →
How To Run Diagnostics and Check Status and How To Perform
Alignment.  

The RSS can be used to service a station connected to the COM port of the
computer.  

The user can use the Service menu windows to:

• run diagnostics and check the status of a station. 

• troubleshoot a station using digital metering.

• perform post-repair or post-installation alignment.
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3.5 Managing Codeplug Data Files

See Online
Help…

Information is available in the Online Help under:  Help menu → Contents  →
How To Manage Codeplug Data Files.  

File management is required to organize backup codeplug data files.  If there is a
problem reading a codeplug data file, its backup file can be loaded.  

It is recommended that:

• archive directories be created as a location for storing backup files

• backup files be created from codeplug data files

All of these tasks are performed through Windows 3.1 or Windows 95 or later.
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4
 How to Use Online Help

The Online Help provides quick access to required information.  Help is initiated from the RSS application
and appears in a Help window on the computer screen.  

This part describes:

• How to initiate the RSS Online Help (Section 4.1). 

• How to navigate through the RSS Online Help; this includes how to use the menu commands and toolbar 
buttons (Section 4.2).  

• How to use jumps to navigate in the Help system (Section 4.3).  

• How to interpret information that has been highlighted with color and symbols (Section 4.4). 

• How to print Online Help (Section 4.5).  

The RSS Online Help is very similar to the Windows Online Help system in appearance and operation.  

See Online
Help…

Information specific to the RSS Online Help is available from the Online Help
window under:  Help menu → Contents  →  How To Use the RSS Online
Help.  
General information on using Windows Help is available:

- from the RSS application window under:   Help menu → Using Help
- from the RSS Online window under:   Help menu → How to Use Help

All of the screen images shown in this manual represent the RSS running under Windows
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3.1.  The description of the Online Help is based on the functionality available in the
Windows 3.1 environment.  Since the Help window (including menu and toolbar) is part of
the Windows operating system, it will reflect any Windows system updates (e.g., Windows
95).  

4.1 Initiating RSS Application Help

The Online Help can be accessed from the RSS application:  

Help menu
commands

- through the RSS window Help menu commands. 
The menu allows the user to access the Help Contents, Help Index, Help 
Glossary and information on how to use Windows help.

<F1> key - by pressing the <F1> key.
When the RSS application is first started, pressing <F1> accesses the Help 
Contents.  Otherwise, pressing <F1> accesses help for the active data field.  
If no data field is active <F1> accesses help for the active application win-
dow.   

RSS application
window Help

button

- by pressing an RSS application window Help command button.  
Help is displayed for the associated application window.  

 Context Help - by initiating Context Help.
Help is available directly for an active RSS application window, menu bar 
commands, and toolbar commands of the RSS application; this is context 
help.  

To access context help when the arrow pointer (p) is active:

1. Activate the context-sensitive help by pressing <shift>-<F1> or clicking on 
the arrow-questionmark toolbar button. 
The arrow-question mark pointer (p?) appears.

2. Click on the desired field for the associated help information.  
The Online Help window appears.

To access context-sensitive help when the field cursor ( ) is active, press the
<F1> key.  The Online Help window appears.

Note
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4.2 Using Online Help

Online Help allows the user to access information in different ways.  

Information related to application activity can be accessed directly through
Context Help or the use of an RSS application window Help command button.  

Information can be found through the Online Help Contents, just as information
would be looked up in a conventional book.  

To access desired information through the Online Help Contents:

1. Select the Help menu Contents command.  
The Online Help Contents is displayed.  

2. Select the desired topic.  
A more detailed list of topics is listed.

3. Select the desired topic.  
The information is displayed in the Help window.  

Toolbar buttons are available to aid the user in finding information.  These
include the Search, History, Glossary, and Index buttons. For details, refer
to subsection, Help Toolbar Buttons.  

There is more than one way to get to the desired information.  For example, to
see information about the Channel Information window, the user could access
the:

- Contents → How to Optimize a New Installation → Channel Infor-
mation,          OR

- Contents → How to Use RSS to Maintain and Program the Station  
→ RSS Menus / Command Descriptions → Personality → Channel 
Info.  

Pointer – When the Online Help window is open, the cursor pointer appears as an arrow or
a hand.  The hand pointer indicates that the pointer is over a field which is a jump
to another place in the Help.  By clicking on the jump, the desired information
appears.  For more information on jumps, refer to Section 4.3.  
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Help Window Screen Elements

A typical Help window is shown in Figure 4-1.  This displayed window has the
following screen elements: 

 

Figure 4-1.          Typical Help Window

Title Bar

Menu Bar

Toolbar

Topic Title

Jump Icon

Help Text

Jumps
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Navigation through the RSS Online Help involves moving through the online
Help system to find the desired information.  

Title Bar The title bar of the Help window indicates the name of the RSS application and
the version number of the Help system.  

Menu Bar This Help menu bar contains the Online Help commands.   

See the Help Menu Bar Commands subsection for command details.  

Toolbar This bar contains buttons for quickly accessing Help commands.

See the Help Toolbar Buttons subsection for toolbar information.  

Topic Title When a topic is chosen, the topic title remains at the top of the Help window, as a
point-of-reference for the user.

Jump Icon A jump icon represents hidden information.  The 3 types of jump icon are expand-
ed text, figure, and table;  see Using Jumps to Navigate In the Help System section
for details.  When the pointer is over a jump, it changes to a hand.  Clicking the
mouse causes the corresponding information to appear.

Help Text This is the information within the Online Help document.  

Jumps A jump is indicated by green underlined text.  When the pointer is over a jump, it
changes to a hand.  Clicking the mouse causes the selected topic to appear.  
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Help Menu Bar Commands     

The following RSS Help commands are available through the menu bar.  The
commands are listed under the menus which contain them.  

File Menu
Commands

The Open... command is used to open a Help file.   

The Print Topic command is used to print the topic that is in the Help window;
only entire topics can be printed. 

The Print Setup command is used to set the printer options before printing a
topic; can select a printer and set or change options for the printer.  The options
available depend on the type of printer selected. 

The Exit command is used to quit Help and save any annotations or bookmarks
created. 

Edit Menu
Commands

The Copy command is used to copy text of the current Help topic to the
Clipboard.  From the Clipboard, the text can be pasted into another application or
document. 

The Annotate command is used to add text to the current Help topic.
Annotations are marked with a paper-clip icon, which appears in front of the
topic heading.  
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Bookmark Menu
Commands

The Define command is used to places a bookmark in the current topic or
remove a bookmark from any topic.  The name specified for the topic appears on
the Bookmark menu. 

The List of Bookmark Names command is available after a bookmark has
been defined.  It is used to chose a bookmark from a list for the topic shown in
the Help window.  

The More command is available when more than 9 bookmarks have been
defined.  It is used to display the complete list of defined bookmark names. 

Help Menu
Commands

The Search for help on… command is used to display a popup.  From this
popup, the user can use the search feature to choose a topic.  

The How to Use Help command is used to display Contents for How To Use
Windows Help. 

The Always on Top command is used to position all Help windows on top of
other windows.  After choosing this command, a shadow appears around the
window border to indicate that the Help windows are on top. 

The Version command is used to display a window which identifies any new or
changed information in this version of the Online Help.  

The About Help command is used to display version and copyright information
about Windows Help and RSS Help.   
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Help Toolbar Buttons

Help toolbar buttons enable easy movement around Help.  If a feature is not
available, its button name is dimmed. 

The following buttons are provided (the appearance of the toolbar buttons shown
below is only valid for the Windows 3.1 environment and is slightly different for
Windows 95):

Contents Displays Online Help Contents for the RSS application. 

Search Lists all the words that can be used to search for topics in the application's Help.
By typing or selecting one of these words, the user can search for and go to a
specific Help topic. 

Back Displays the last topic viewed.  The user can move back one topic at a time in the
order the topics were viewed. 

History Displays the last 40 topics you have viewed in the Windows session. The most
recent topic viewed is listed first. To revisit a topic, double-click it. 

Glossary Provides access to popups which define terms and acronyms.    

Index The Index button displays an alphabetical listing of words which are jumps to
detailed information.  

<< This browse button displays the previous topic in a series of related topics, until
you reach the first topic in the series. The button is then dimmed. 

>> This browse button  the next topic in a series of related topics, until you reach the
last topic in the series. The button is then dimmed. 
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4.3 Using Jumps to Navigate In the Help System

Jumps are tools which allow the user to move around within the Online Help
system.  Clicking on a jump can open:

- another window, 

- a secondary window, or 

- a popup.  

Generally, jumps are indicated by green text or special icons.   Table 4-1 lists the
types of jumps found in the Online Help system.  Each icon can be expanded (by
clicking on the icon) to provide more detailed or graphical information.
Normally this information is hidden, to provide the user with optimum
information access speed.  

Table 4-1.        Jumps in the RSS Online Help 

Jump Shown as... Use

jump to window underlined green text. Indicates a jump to another 
online window.

jump to popup dot-underlined green 
text.   

Indicates a jump to a popup.  

the “expand text” icon, 
accompanied by an 
underlined green text 
title.  

Indicates that details are 
hidden and are only shown 
at a users request.  These 
details are not always 
applicable or are performed 
only once.  

the “figure” icon, 
accompanied by an 
underlined green figure 
title.  

Indicates that a detailed 
illustrations is hidden from 
view and is only viewed if 
required.   

the “table” icon, 
accompanied by an 
underlined green table 
title.  

Long tables are hidden from 
view and are only viewed if 
required.   
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4.4 Interpreting Highlight Colors and Symbols

Color is used in the Online Help system to highlight particular information.
Table 4-2 identifies the colors used and their significance.  

Table 4-2.        Color In the RSS Online Help   

Color Appearance Use

Green Underlined Indicates a jump to another online 
window.

Broken 
underlined

Indicates a jump to a popup window.  

Blue NOTE The word NOTE precedes note text.

Red The Warning symbol precedes notes 
which indicate the potential for 
personal injury or serious system 
degradation unless the proper action 
is taken.  

Yellow The Caution symbol precedes notes 
which indicate a potential problem 
unless the appropriate actions are 
taken.  

STOP

Warning

Caution
!
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4.5 Printing Online Help

The user can print:

• an individual Help topic, or 

• an entire section of the Online Help document.

Print a topic To print a Help topic, select the File menu Print Topic command.  If necessary,
use the Print Setup... command to configure the printer.  

Print Online
document

To print an entire section of the Online Help document:

1. Start MS Word or another word processing application which can access .rtf 
files. 

2. Open one of the Online Help files through the File menu Open command.  
For example, select the options.rtf file. 

3. Print the file through File menu Print command.

The printable files which correspond to the Online Help document sections are:

.rtf (rich text format) files may be accessed by word processing applications other
than MS Word. 

contents.rtf Table of Contents structure starting from the overall level of the help content
information.

index.rtf Provides an alphabetically sorted index of related help topics.  

glossary.rtf Provides a short description of terms used.  

startup.rtf Describes how to start and use the RSS.  

general.rtf Describes all RSS screen components, RSS menus, and commands.

options.rtf Describes all windows with user editable data (e.g., Channel Information, rf 
Options).  

service.rtf Describes all service and alignment windows, and associated procedures.

Note
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